


Microsoft® Word® 2010 On Demand

Copyright © 2011 by Perspection, Inc.

All rights reserved. No part of this book shall be reproduced, stored in a
retrieval system, or transmitted by any means, electronic, mechanical,
photocopying, recording, or otherwise, without written permission from the
publisher. No patent liability is assumed with respect to the use of the infor-
mation contained herein. Although every precaution has been taken in the
preparation of this book, the publisher and author assume no responsibility
for errors or omissions. Nor is any liability assumed for damages resulting
from the use of the information contained herein.

Library of Congress Cataloging-in-Publication Data is on file
ISBN-13: 978-0-7897-4281-0
ISBN-10: 0-7897-4281-0

Printed and bound in the United States of America
First Printing: July 2010
13  12  11  10             4  3  2  1  

Que Publishing offers excellent discounts on this book when ordered 
in quantity for bulk purchases or special sales. 
For information, please contact: U.S. Corporate and Government Sales

1-800-382-3419 or corpsales@pearsontechgroup.com
For sales outside the U.S., please contact: International Sales

1-317-428-3341 or International@pearsontechgroup.com

Trademarks

All terms mentioned in this book that are known to be trademarks or service
marks have been appropriately capitalized. Que cannot attest to the accuracy
of this information. Use of a term in this book should not be regarded as
affecting the validity of any trademark or service mark. 

Microsoft and the Microsoft Office logo are registered trademarks of Microsoft
Corporation in the United States and/or other countries.

Warning and Disclaimer

Every effort has been made to make this book as complete and as accurate as
possible, but no warranty or fitness is implied. The authors and the publishers
shall have neither liability nor responsibility to any person or entity with
respect to any loss or damage arising from the information contained in this
book.

Publisher
Paul Boger

Associate Publisher
Greg Wiegand

Acquisitions Editor
Loretta Yates

Managing Editor
Steve Johnson

Author
Steve Johnson

Technical Editor
Beth Teyler

Page Layout
James Teyler

Interior Designers
Steve Johnson
Marian Hartsough

Photographs
Tracy Teyler

Indexer
Katherine Stimson

Proofreader
Beth Teyler

Team Coordinator
Cindy Teeters

sivaranjani
Approved



vii

Contents

c

c
Introduction xvii

Getting Started with Word 1

Starting Word 2 New!

Viewing the Word Window 3
Using the Ribbon 4 New!

Choosing Commands 5 New!

Working with Toolbars 6 New!

Choosing Dialog Box Options 8
Using the Status Bar 9
Using Task and Window Panes 10   
Opening an Existing Document 12 New!

Opening Files of Different Types 14
Converting an Existing Document 15 New!

Changing Document Views 16 New!

Reading a Document 18 New!

Getting Help While You Work 20
Saving a Document 22
Saving a Document with Different Formats 24
Checking Compatibility 26 New!

Checking Accessibility 27 New!

Documenting Properties 28
Zooming the View In and Out 29
Recovering a Document 30 New!

Maintaining and Repairing Office 32
Getting Updates on the Web 33
Closing a Document and Exiting Word 34

Working with Simple Documents 35

Creating a Blank Document 36
Creating a New Document From an Existing One 37
Creating a Document Using a Template 38

2

1



viii Contents

c

Creating a Letter or Memo 39
Setting Up the Page 40
Moving and Resizing Document Windows 42
Working with Multiple Documents 44
Navigating a Document 46 New!

Moving Around in a Document 47
Selecting Text 48
Editing Text 50
Copying and Moving Text 52 New!

Finding and Replacing Text 54 New!

Inserting Hyphens 56
Inserting Information the Smart Way 58 New!

Correcting Text Automatically 60 New!

Undoing and Redoing an Action 62

Formatting Documents 63

Formatting Text 64
Formatting Text for Emphasis 66 New!

Changing Character Spacing 68 New!

Selecting Text with Similar Formatting 69
Finding and Replacing Formatting 70
Finding and Replacing Custom Formatting 72
Changing Paragraph Alignment 74
Changing Line Spacing 75
Displaying Rulers 76
Setting Paragraph Tabs 77
Setting Paragraph Indents 78
Creating Bulleted and Numbered Lists 80 New!

Applying Borders and Shading 82
Hiding Text 84

Using Templates, Styles, and Themes 85

Creating a Template 86
Opening a Template 87
Changing a Template 88
Applying a Quick Style 89
Changing a Style Set 90
Creating and Modifying Styles 92
Managing Styles 94
Revealing Formatting Styles 96
Using a Format Painter 98

4

3



Contents ix

c

Adding Custom Colors 99
Understanding Themes 100
Viewing and Applying a Theme 101 New!

Creating Theme Colors 102
Choosing Theme Fonts 104
Choosing Theme Effects 106
Creating a Custom Theme 107
Choosing a Custom Theme 108

Adding Graphics and Multimedia to Documents 109

Locating and Inserting Clip Art 110 New!

Inserting a Picture 111
Inserting a Picture Screen Shot 112 New!

Adding an Artistic Style to a Picture 113 New!

Adding a Quick Style to a Picture 114
Applying a Shape to a Picture 115 New!

Applying a Border to a Picture 116
Applying Picture Effects 117
Modifying Picture Size 118
Compressing a Picture 120 New!

Correcting a Picture 121 New!

Recoloring a Picture 122 New!

Cropping and Rotating a Picture 124 New!

Removing a Picture Background 126 New!

Creating WordArt Text 127
Formatting WordArt Text 128
Applying WordArt Text Effects 130
Modifying WordArt Text Position 131
Creating SmartArt Graphics 132 New!

Using the Text Pane with SmartArt Graphics 134
Formatting a SmartArt Graphic 136
Modifying a SmartArt Graphic 138
Adding Pictures to a SmartArt Graphic 140 New!

Creating an Organization Chart 141
Modifying an Organization Chart 142

Adding Tables and Charts to Documents 143

Creating a Table 144
Entering Text in a Table 146
Sorting Table Contents or Lists 147
Modifying a Table 148

6

5



x Contents

c

Adjusting Table Cells 150
Aligning Table Cells 152
Adding a Quick Style to a Table 154
Changing Table Style Options 156
Summing Table Rows and Columns 157
Calculating a Value in a Table 158
Inserting and Creating a Chart 159
Working with Chart Data 160
Changing a Chart Type 162
Changing a Chart Layout and Style 163 New!

Changing Chart Titles 164
Changing Chart Labels 165
Formatting Line and Bar Charts 166
Editing Chart Data 167 New!

Saving a Chart Template 168

Creating Desktop Publishing Documents 169

Adding Desktop Publishing Effects 170
Adding a Watermark 172 New!

Adding Page Backgrounds 174
Arranging Text in Columns 176
Wrapping Text Around an Object 178
Working with Text Boxes 180 New!

Drawing and Resizing Shapes 182
Adding Text to a Shape 184
Creating and Editing Freeforms 185
Adding a Quick Style to a Shape 186
Adding Formatting to Shape Text 187 New!

Applying Color Fills 188
Applying Picture or Texture Fills 190
Applying Gradient Fills 191 New!

Applying Shape Effects 192 New!

Aligning and Distributing Objects 194
Aligning Objects to Grids 196
Changing Stacking Order 198
Rotating and Flipping Objects 199
Grouping and Ungrouping Objects 200

Working with Long Documents 203

Creating an Outline 204
Creating a Multiple-Author Document 206

8

7



Contents xi

c

Creating Documents Using Automatic Formatting 208
Creating Headers and Footers 210
Inserting Page Numbers and the Date and Time 212
Inserting Cross References 214
Preparing for a Bound Document 215
Finding Topics in a Long Document 216 New!

Navigating a Long Document 217
Inserting a Table of Contents 218
Creating an Index 220
Determining Word Count Statistics 222
Adding a Cover Page 223 New!

Working with Technical Documents 225

Inserting Building Blocks Using Quick Parts 226
Inserting and Creating AutoText 228 New!

Inserting Research Material 230
Creating Footnotes or Endnotes 232
Modifying Footnotes or Endnotes 233
Formatting Footnotes or Endnotes 234
Creating a Bibliography 236
Creating a Bookmark 238
Creating Captions 240
Creating a Table of Figures 241
Numbering Lines 242
Creating an Equation 244
Inserting Symbols 246

Creating Mail Merge Documents 249

Starting the Mail Merge 250
Importing Data from a Database 251
Importing Data from Outlook 252
Creating a Data Document 253
Editing the Data Source 254
Sorting and Filtering Data 255
Creating a Form Letter 256
Previewing the Mail Merge 258
Completing the Mail Merge 259
Merging to E-mail 260 
Creating Merged Mailing Labels 262
Creating Merged Envelopes 264
Addressing Envelopes and Labels 266

10

9



xii Contents

c

Proofing and Printing Documents 267

Checking for Inconsistent Formatting 268
Checking Spelling and Grammar 270
Using Custom Dictionaries 272
Changing Proofing Options 274 New!

Setting Languages for Proofing 276
Translating Text to Another Language 278 New!

Using Multiple Languages 280 New!

Finding the Right Words 281
Setting Up Page Margins 282
Adjusting Paper Settings 284
Controlling the Way Pages Break 285
Inserting New Pages and Sections 286
Previewing a Document 288 New!

Printing a Document 289 New!

Printing Specialized Documents 290
Printing Document Properties 292

Publishing Documents on the Web 293

Opening a Web Page 294
Previewing a Web Page 296
Creating Hyperlinks 298
Creating a Hyperlink Between Frames 300
Using and Removing Hyperlinks 302
Saving a Web Page 304
Changing Web Page Options 306
Transferring Files Over the Web 307
Creating a Blog Posting on the Web 308
Opening an Existing Blog Posting 310
Managing Blog Accounts 311
Accessing Office Information on the Web 312

Protecting and Securing Documents 313

Inspecting Documents 314 New!

Adding Security Encryption to a Document 316
Adding Password Protection to a Document 318
Restricting Formatting and Editing 320
Adding a Digital Signature 322
Adding a Signature Line 324
Avoiding Harmful Attacks 326

13

12

11



Contents xiii

c

Using the Trust Center 328 New!

Selecting Trusted Publishers and Locations 329
Setting Document Related Security Options 330 New!

Setting Add-in Security Options 332
Setting ActiveX Security Options 333
Setting Macro Security Options 334
Changing Message Bar Security Options 335
Setting Privacy Options 336
Working with Office Safe Modes 338
Marking a Document as Read-Only 340

Reviewing and Sharing Documents 341

Preparing for Comments and Track Changes 342
Inserting Comments 344
Reading and Editing Comments 346
Using Track Changes 348
Modifying Track Changes Options 350
Comparing and Merging Documents 351
Sharing Templates 352
Sending a Document for Review Using E-mail 354
Sending a Document by Internet Fax 356

Sharing Information Between Programs 357

Sharing Information Between Programs 358
Exporting and Importing Data 360 New!

Linking and Embedding Files 362
Creating an XML Document 364
Working with XML Data 366
Creating a Word Document with Excel Data 368 New!

Creating a Presentation with Word Text 370 New!

Using an Access Database to Create Word Documents 372
Creating a Word Outline from a Presentation 374
Creating and Opening OneNotes 375 New!

Creating a PDF Document 376
Creating an XPS Document 377

Customizing Word 379

Setting General Options 380
Setting Page Display Options 381
Setting Display Options 382 New!

Setting Print Options 384

16

15

14



xiv Contents

c

Setting Editing Options 386 New!

Changing Default Text and Page Settings 388 New!

Setting Advanced Save Options 390
Setting Advanced General Options 392 New!

Setting Compatibility Options 393
Changing Advanced Document Properties 394
Changing Research Options 395 New!

Accessing Commands Not in the Ribbon 396
Customizing the Way You Create Objects 397
Managing Pictures 398

Expanding Word Functionality 401

Viewing and Managing Add-ins 402 New!

Loading and Unloading Add-ins 404
Enhancing a Document with VBA 406
Viewing the Visual Basic Editor 408
Setting Developer Options 409
Understanding How Macros Automate Your Work 410
Recording a Macro 411 New!

Creating a Macro 412
Running a Macro 413
Controlling a Macro 414
Adding a Digital Signature to a Macro Project 416
Assigning a Macro to a Toolbar 417
Saving a Document with Macros 418
Opening a Document with Macros 419 New!

Using Content Controls to Create Documents 420
Inserting ActiveX Controls 422 New!

Using ActiveX Controls 424
Setting ActiveX Control Properties 425
Adding VBA Code to an Active Control 426
Playing a Movie Using an ActiveX Control 427
Changing the Document Information Panel 428 

Working Together on Office Documents 429

Getting Started with Office Web Apps 430 New!

Setting Up to Use Office Web Apps 432 New!

Saving and Opening Documents with Windows Live 434 New!

Comparing the Desktop App to Web App 436 New!

Accessing Documents on Windows Live 438 New!

Working with Folders on Windows Live 440

18

17



Contents xv

c

Setting Folder Permissions on Windows Live 442
Creating Office Documents on Windows Live 443 New!

Working with Documents on Windows Live 444
Downloading Documents from Windows Live 446
Downloading or Saving Documents in Office Web Apps 448 New!

Collaborating with Documents on Windows Live 450 New!

Working with SharePoint Workspaces 452 New!

Sharing Documents in a Groove Workspace 454 New!

Inviting Others to a Groove Workspace 455 New!

Saving a Document to a SharePoint Server 456 New!

Using Office Mobile 2010 458 New!

Workshops: Putting It All Together 459

Project 1: Creating a Form with Content Controls 459
Project 2: Exporting Form Data to Access or Excel 462
Project 3: Viewing XML Data in a Document 464
Want More Projects 465

New Features 467 New!

Microsoft Certified Applications Specialist 473
Index 481

W



This page intentionally left blank 



xvii

Introduction

Welcome to Microsoft Word 2010 On Demand, a visual quick
reference book that shows you how to work efficiently with
Microsoft Word.  This book provides complete coverage of
basic to advanced Word skills.

How This Book Works
You don’t have to read this book in any particular order.
We’ve designed the book so that you can jump in, get the
information you need, and jump out. However, the book does
follow a logical progression from simple tasks to more com-
plex ones. Each task is presented on no more than two facing
pages, which lets you focus on a single task without having
to turn the page. To find the information that you need, just
look up the task in the table of contents or index, and turn to
the page listed. Read the task introduction, follow the step-
by-step instructions in the left column along with screen illus-
trations in the right column, and you’re done.

What’s New
If you’re searching for what’s new in Word 2010, just look for
the icon: New!. The new icon appears in the table of contents
and throughout this book so you can quickly and easily iden-
tify a new or improved feature in Word 2010. A complete
description of each new feature appears in the New Features
guide in the back of this book.

Keyboard Shortcuts
Most menu commands have a keyboard equivalent, such as
Ctrl+P, as a quicker alternative to using the mouse. A com-
plete list of keyboard shortcuts is available on the Web 
at www.perspection.com.

How You’ll Learn

How This Book Works

What’s New

Keyboard Shortcuts

Step-by-Step Instructions

Real World Examples

Workshops

Microsoft Certified Applications
Specialist

Get More on the Web

www.perspection.com


xviii Introduction

Step-by-Step
Instructions
This book provides concise step-
by-step instructions that show you
“how” to accomplish a task. Each
set of instructions includes illus-
trations that directly correspond to
the easy-to-read steps. Also
included in the text are time-
savers, tables, and sidebars to
help you work more efficiently or
to teach you more in-depth infor-
mation. A “Did You Know?” pro-
vides tips and techniques to help
you work smarter, while a “See
Also” leads you to other parts of
the book containing related infor-
mation about the task. 

Real World Examples
This book uses real world exam-
ples files to give you a context in
which to use the task. By using
the example files, you won’t waste
time looking for or creating sam-
ple files. You get a start file and a
result file, so you can compare
your work. Not every topic needs
an example file, such as changing
options, so we provide a complete
list of the example files used
through out the book. The exam-
ple files that you need for project
tasks along with a complete file
list are available on the Web at
www.perspection.com.

Real world
examples help
you apply what
you’ve learned
to other tasks.

Illustrations
match the
numbered
steps.

Numbered
steps guide
you through
each task.

Did You Know? alerts
you to tips, techniques
and related information.

See Also points you to
related information in
the book.

Easy-to-follow
introductions
focus on a
single concept.

www.perspection.com


Workshops
This book shows you how to put
together the individual step-by-
step tasks into in-depth projects
with the Workshops. You start each
project with a sample file, work
through the steps, and then com-
pare your results with a project
results file at the end. The Work-
shop projects and associated files
are available on the Web at
www.perspection.com.

Microsoft Certified
Applications Specialist
This book prepares you for the
Microsoft Certified Applications
Specialist (MCAS) exam for
Microsoft Word 2010 program.
Each MCAS certification exam has
a set of objectives, which are
organized into broader skill sets.
To prepare for the certification
exam, you should review and per-
form each task identified with a
MCAS objective to confirm that
you can meet the requirements for
the exam. Information about the
MCAS program is available in the
back of this book. The MCAS
objectives and the specific pages
that cover them are available on
the Web at www.perspection.com.

The Workshops
walks you
through in-depth
projects to help
you put Microsoft
Word to work.

Introduction xix

www.perspection.com
www.perspection.com


xx Introduction

Get More on the Web
In addition to the information in
this book, you can also get more
information on the Web to help
you get up to speed faster with
Word 2010. Some of the informa-
tion includes: 

Transition Helpers
◆ Only New Features.

Download and print the new
feature tasks as a quick and
easy guide.

Productivity Tools
◆ Keyboard Shortcuts.

Download a list of keyboard
shortcuts to learn faster ways
to get the job done. 

More Content
◆ Photographs. Download

photographs and other
graphics to use in your Office
documents.

◆ More Content. Download
new content developed after
publication. For example,
you can download a
complete chapter on Groove
or SharePoint Workspaces.

You can access these additional
resources on the Web at
www.perspection.com.

Additional content 
is available on the
Web. You can
download a chapter
on Groove or
SharePoint
workspaces.

www.perspection.com


Formatting Documents

Introduction

Once you type a document and get the content how you
want it, the finishing touches can sometimes be the most
important. An eye catching document will draw the reader in,
while a boring font without a lot of extra details will draw the
reader away from all your hard work. To create that interest,
Microsoft Word can help you change your document for a
fresh look. One of the first elements you can change is your
font attributes. Applying bold, underline, or italics when
appropriate, can emphasize text. You might find that having
different font sizes in your document to denote various topics
will also enhance your document.

You can change the kerning—the amount of space
between each individual character, for a special effect on a
title or other parts of text. You can also apply a dropped capi-
tal letter to introduce a body of text, add a shading or border
onto your document.

Word has various tools to help you format your docu-
ment. You can search and replace formatting effects, display
rulers, change a paragraph alignment, set paragraph tabs
and indents, and change your line spacing. There are times
when typing a paragraph will not do your text justice.
Creating a bulleted or numbered list might better show your
information. To further enhance the appearance of the text in
a paragraph, you can quickly add a border and shading to
selected text. If you have confidential information in a docu-
ment or text that you don’t want others to see, you can use a
formatting option to hide the text. 3

3
What You’ll Do

Format Text

Format Text for Emphasis

Change Character Spacing

Select Text with Similar Formatting

Find and Replace Formatting

Find and Replace Custom Formatting

Change Paragraph Alignment

Change Line Spacing

Display Rulers

Set Paragraph Tabs

Set Paragraph Indents

Create Bulleted and Numbered Lists

Apply Borders and Shading

Hide Text

63



64 Chapter 3

A font is a collection of alphanumeric characters that share the same
typeface, or design, and have similar characteristics. You can format
text and numbers with font attributes—such as bolding, italics, or
underlining—to enhance data to catch the reader’s attention. The main
formats you apply to text are available on the Home tab in the Font
group or in the Font dialog box. Some of the formats available include
strikethrough, subscript, superscript, and underline style and color.
When you point to selected text, Office displays the Mini-Toolbar above
it. The Mini-Toolbar provides easy access to common formatting tool-
bar buttons, such as font, font size, increase and decrease font size,
bold, italic, font color, and increase and decrease list level. If you don’t
want to display the Mini-Toolbar, you can use Word Options to turn it
off.

32

Mini-toolbar

Formatting Text

Format Text Quickly

Select the text you want to format.

Click the Home tab.

To change fonts, click the Font list
arrow on the Ribbon or Mini-
Toolbar, and then point for a live
preview, or click the font you want,
either a theme font or any available
fonts.

The font name appears in the font
style.

To change the font size, click one
or more of the font size buttons on
the Ribbon or Mini-Toolbar:

◆ Click the Font Size list arrow,
and then click the font size 
you want.

◆ Click the Increase Font Size
button or Decrease Font Size
button.

To apply other formatting, click one
or more of the formatting buttons
on the Ribbon or Mini-Toolbar:
Bold, Italic, Underline, Shadow,
Strikethrough, or Font Color.

◆ To select an underline style,
click the Underline button
arrow, and then select a style 
or color. 

3

2

1

1



Chapter 3 Formatting Documents 65

Format Text Using the Font
Dialog Box

Select the text you want to format.

Click the Home tab.

Click the Font Dialog Box
Launcher.

The Font dialog box opens,
displaying the Font tab.

Select the font, font style, and font
size you want.

If you want, click the Font Color
list arrow, and then click a color. 

If you want, click the Underline list
arrow, click a style, click
Underline Color list arrow, and
then click a color.

Click OK.7

6

5

4

3

2

1

32

1

75

4

6

Preview box

Did You Know?
You can tell the difference between a
TrueType and printer font. A TrueType
(outline) font is a font that uses special
software capabilities to print exactly
what is seen on the screen. A printer
(screen) font is a font that comes only
in specified sizes. If you are creating a
document for publication, you need to
use printer fonts.

What is a point? The size of each font
character is measured in points (a
point is approximately 1/72 of an inch). 

Each computer has different fonts
installed. Users with whom you share
files may not have all the fonts you’ve
used in a document installed on their
computers.



66 Chapter 3

You’ll often want to format, or change the style of, certain words or
phrases to add emphasis to parts of a document. In addition to the stan-
dard formatting options—Bold, Italic, Underline, etc.—Word provides
additional formatting effects to text, including Font Color, Gradient
(New!), Shadow (New!), Outline (New!), Reflection (New!), Glow
(New!), 3-D (New!), Highlight, Strikethrough, Superscript, Subscript,
Small Caps, All Caps, and Hidden. To help you format sentences and
change capitalization, you can change text case. 

Formatting Text for
Emphasis

Apply Formatting Text Effects

Select the text you want to format.

Click the Home tab.

Click the formatting (Font, Font
Style, Size, Bold, Italic, Underline
(select a style and color), Strike-
through, Superscript, Subscript, or
Font Color (select a color or a
Gradient (New!)) you want.

To add a visual effect to text, click
the Text Effect button (New!), and
then click the option you want:

◆ A combination text effect.
◆ Outline
◆ Shadow
◆ Reflection
◆ Glow
◆ Clear Text Effects. Removes

effect.

To change text case, click the
Case button, and then click the
option you want:

◆ Sentence case.
◆ lowercase
◆ UPPERCASE
◆ Capitalize Each Word
◆ tOGGLEcASE
To highlight text, click the Text
Highlight Color button arrow, and
then click the color you want.

◆ Add highlight. Click a color.

◆ Remove highlight. Click No
Color.

6

5

4

3

2

1

1

2 3

5

4

6 All caps and highlighted text



Chapter 3 Formatting Documents 67

Apply Other Formatting Effects 
to Text

Select the text you want to format.

Click the Home tab.

Click the Font Dialog Box
Launcher.

Click the formatting (Font, Font
Style, Size, Font color, Underline
style, and Underline color) you
want.

Click to select the effects (Strike-
through, Double strikethrough,
Superscript, Subscript, Small
caps, All caps, and Hidden) you
want.

To custom text effects, such as a
text fill or outline with a solid or
gradient, shadow, reflection, glow
and soft edges, or 3-D format, click
Text Effects, specify the options
you want, and then click Close
(New!).

Check the results in the Preview
box.

To make the new formatting
options the default for all new
Word documents, click Set As
Default, and then click Yes.

Click OK.9

8

7

6

5

4

3

2

1

7

9

5

4

8

Did You Know?
You can quickly clear formatting.
Select the text to which you want to
clear formatting, click the Home tab,
and then click the Clear Formatting
button.

Strikethrough textText effect

6

All caps and highlighted text

Text effects



68 Chapter 3

Kerning is the amount of space between each individual character that
you type. Sometimes the space between two characters is larger than
others, which makes the word look uneven. You can use the Font dialog
box to change the kerning setting for selected characters. Kerning
works only with OpenType/TrueType or Adobe Type Manager fonts. You
can expand or condense character spacing to create a special effect
for a title, or re-align the position of characters to the bottom edge of
the text—this is helpful for positioning the copyright or trademark sym-
bols. In addition, you can set text formatting for OpenType/TrueType
fonts (New!) that include a range of ligature settings (where two or
three letters combine into a single character), number spacing and
forms, and stylistic sets (added font sets in a given font). Many of these
options are based on specifications from font designers.

Changing Character
Spacing

Change Character Spacing

Select the text you want to format.

Click the Home tab.

Click the Font Dialog Box
Launcher.

Click the Advanced tab.

Click the Spacing list arrow, click
an option, and then specify a point
size to expand or condense
spacing by the amount specified.

Click the Position list arrow, click
an option, and then specify a point
size to raise or lower the text in
relation to the baseline (bottom of
the text). 

Select the Kerning for fonts check
box, and then specify a point size.

Check the results in the Preview
box.

To make the new formatting
options the default for all new
Word documents, click Set As
Default, and then click Yes.

Click OK.10

9

8

7

6

5
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Chapter 3 Formatting Documents 69

A quick way to select text with similar formatting is to use the Select
Text with Similar Formatting command. After you select the text with
the formatting you want to find, click the Select button on the Home
tab, and then choose the Select Text with Similar Formatting command.
Word highlights all the text with similar formatting in the document.
With the text selected, you can change the text formatting.

Selecting Text with
Similar Formatting

Select Similar Text Formatting

Select the text you want to find.

Click the Home tab.

Click the Select button, and then
click Select Text with Similar
Formatting.

3

2

1
2

3

1

Did You Know?
You can quickly clear formatting.
Select the text to which you want to
clear formatting, click the Home tab,
and then click the Clear Formatting
button.

See Also
See “Revealing Formatting Styles” on
page 96 for more information on using
the Select Text With Similar Formatting
command.

Selected results
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Suddenly you realize all the bold text in your report would be easier to
read in italics. Do you spend time making these changes one by one?
No. The Find and Replace feature locates the formatting and instantly
substitutes new formatting. If your search for a formatting change is an
easy one, click Less in the Find and Replace dialog box to decrease the
size of the dialog box. If your search is a more complex one, click More
to display additional options. With the Match Case option, you can
specify exact capitalization. The Reading Highlight button highlights
items found to make them easier to read. The Go To tab quickly moves
you to a place or item in your document.

Finding and 
Replacing
Formatting

Find Formatting

Click the Home tab.

Click the Find button arrow, and
then click Advanced Find.

To clear any previous settings,
click No Formatting.

If you want to locate formatted
text, type the word or words.

Click More, click Format, and then
click the formatting you want to
find.

To highlight located items, click
Reading Highlight, and then click
Highlight All.

Click Find Next to select the next
instance of the formatted text.

Click OK to confirm Word finished
the search.

Click Close or Cancel.9

8

7

6

5

4

3

2

1

9

5

21 Current find settings

4

7

6

3
Switches from

More to Less

Did You Know?
You can find an item or location.
Click the Home tab, click the Find but-
ton arrow, click Go To, click an item to
find (an item, such as a bookmark or
comment or location, such as a page
or section), enter an item number or
name, click Next, Previous, or Go To to
locate the item, and then click Close.
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Replace Formatting

Click the Home tab.

Click the Replace button.

If you want to locate formatted
text, type the word or words. 

Click the More button, click
Format, and then click the
formatting you want to find. When
you’re done, click OK.

Press Tab, and then type any text
you want to substitute.

Click Format, and then click the
formatting you want to substitute.
When you’re done, click OK.

To substitute every instance of the
formatting, click Replace All.

To substitute the formatting one
instance at a time, click Find Next,
and then click Replace.

If you want to cancel the replace,
click Cancel.

If necessary, click Yes to search
from the beginning of the
document.

Click OK to confirm Word finished
searching.

Click Close or Cancel.10
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Did You Know?

You can find and replace special char-
acters and document elements.
In Word, you can search for and
replace special characters (for exam-
ple, an em dash) and document ele-
ments (for example, a tab character).
Click More in the Find and Replace dia-
log box, click Special, and then click
the item you want from the menu.



72 Chapter 3

If your search for formatting involves a complex search for a specific
type of formatted text, click More in the Find and Replace dialog box to
increase the size of the dialog box and display additional options. The
expanded Find and Replace dialog box provides options to find exact
capitalization, find whole words only, use wildcards, and locate words
that sound like English or different forms of English words. With the
Special button, you can find and replace special characters and ele-
ments, such as graphics, tabs, fields, white space, and page breaks. 

Finding and Replacing
Custom Formatting

Find or Replace Special
Formatting

Click the Home tab.

Click the Find button arrow, and
then click Advanced Find or click
the Replace button.

To clear any previous settings,
click No Formatting.

If you want to locate formatted
text, type the word or words you
want to find and/or replace.

Click More to expand the dialog
box.

Click Special, and then click the
specialized formatting item you
want to find.

Click Find Next to select the next
instance of the formatted text.

To substitute every instance of the
formatting, click Replace All.

To substitute the formatting one
instance at a time, click Find Next,
and then click Replace.

Click OK to confirm Word finished
the search.

Click Close or Cancel.10

9

8

7

6

5

4

3

2

1

3

7

6

4

10

Switches from More to Less5
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Use Find and Replace Options

Click the Home tab.

Click the Find or Replace button.

To clear any previous settings,
click No Formatting.

If you want to locate formatted
text, type the word or words you
want to find and/or replace.

Click More, and then select or
clear the options you want:

◆ Search. Select a search
direction: All, Down, or Up.

◆ Match Case. Select to find
exact capitalization.

◆ Find whole words only. Select
to find words with space on
either side.

◆ Use wildcards. Select to use
wildcards, such as asterisk (*)
or question mark (?).

◆ Sounds like (English). Select to
find English sounding words.

◆ Find all word forms (English).
Select to find all English forms
of a word.

◆ Match prefix or Match suffix.
Select to find text at the
beginning or end of a word.

◆ Ignore punctuation characters
or Ignore white-space
characters. Select to ignore
punctuation (periods, commas,
etc.) or white space
characters.

Click Find Next to select the next
instance of the formatted text, or
click Replace

Click OK to confirm Word finished
the search.

Click Close or Cancel.8
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Switches from
More to Less5

Using Wildcards

A wildcard allows you to search for variable text.  For example, you
can use the asterisk (*) wildcard to search for a string of characters
("s*d" finds "sad" and "started"), or use the question mark (?) wildcard to
search for any single character (s?t finds "sat" and "set"). To search for
a character that's defined as a wildcard, type a backslash (\) before
the character. For example, type \? to find a question mark. 

For Your Information



Text starts out positioned evenly along the left margin, and uneven, or
ragged, at the right margin. Left-aligned text works well for body para-
graphs in most cases, but other alignments vary the look of a document
and help lead the reader through the text. Right-aligned text, which is
even along the right margin and ragged at the left margin, is good for
adding a date to a letter. Justified text spreads text evenly between the
margins, creating a clean, professional look, often used in newspapers
and magazines. Centered text is best for titles and headings. You can
use Click-And-Type to quickly center titles or set different text align-
ment on the same line, or you can use the alignment buttons on the
Home tab to set alignment on one or more lines.
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Changing Paragraph
Alignment

Align New Text with 
Click-And-Type

◆ Position the I-beam at the left,
right, or center of the line where
you want to insert new text.

When the I-beam shows the
appropriate alignment, double-
click to place the insertion point,
and then type your text. 

Align Existing Text

Position the I-beam, or select at
least one line in each paragraph to
align.

Click the appropriate button on the
Home tab. 

◆ Align Left button

◆ Center button

◆ Align Right button

◆ Justify button

2

1

Pointer Purpose

Left-aligns text

Right-aligns text

Centers text

Creates a new line in the same paragraph

Creates a text around a picture

Click-And-Type Text Pointers

1

2



The lines in all Word documents are single-spaced by default, which is
appropriate for letters and most documents. But you can easily change
your document line spacing to double or 1.5 lines to allow extra space
between every line. This is useful when you want to make notes on a
printed document. Sometimes, you’ll want to add space above and
below certain paragraphs, for headlines, or indented quotations to help
set off the text.
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Changing Line 
Spacing

Change Line Spacing

Select the text you want to
change.

Click the Home tab.

Click the Line Spacing button
arrow, and then click a spacing
option.

◆ To apply a new setting, click
the number you want.

◆ To apply the setting you last
used, click the Line Spacing
button.

◆ To enter precise parameters,
click Line Spacing Options,
specify the line or paragraph
settings you want, and then
click OK.

◆ To apply the setting you last
used, click Add Space Before
Paragraph or Add Space After
Paragraph.

TIMESAVER Press Ctrl+1 for
single-spacing, Ctrl+5 for 1.5
spacing, or Ctrl+2 for double-
spacing.

3
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32

Line Spacing Options
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Word rulers do more than measure. The horizontal ruler above the doc-
ument shows the length of the typing line and lets you quickly adjust
left and right margins and indents, set tabs, and change column widths.
The vertical ruler along the left edge of the document lets you adjust
top and bottom margins and change table row heights. You can hide
the rulers to get more room for your document. As you work with long
documents, use the document map to jump to any heading in your doc-
ument. Headings are in the left pane and documents in the right. 

Displaying Rulers

Show and Hide the Rulers

Click the View tab.

Select or clear the Ruler check
box.

TIMESAVER Click the View
Ruler button at the top of the
vertical scroll bar.

◆ To view the horizontal ruler,
click the Web Layout View or
Draft View button.

◆ To view the horizontal and
vertical rulers, click the Print
Layout View button.

2

1
12

View
Ruler
button

Did You Know?
You can change the ruler measure-
ments. Change the ruler to show
inches, centimeters, millimeters,
points, or picas. Click the File tab, click
Options, click Advanced, click the
Show Measurement In Units list arrow,
select the measurement you want, and
then click OK.

You can set your text to be hyphen-
ated. Hyphenation prevents ugly gaps
and short lines in text. Click the Page
Layout tab, click the Hyphenation but-
ton, and then click None, Automatic, or
Manual, or Hyphenation Options. Click
Hyphenation Options to set the
hyphenation zone and limit the number
of consecutive hyphens (usually two),
and then click OK.



In your document, tabs set how text or numerical data aligns in relation
to the document margins. A tab stop is a predefined stopping point
along the document’s typing line. Default tab stops are set every half-
inch, but you can set multiple tabs per paragraph at any location.
Choose from four text tab stops: left, right, center, and decimal (for
numerical data). The bar tab inserts a vertical bar at the tab stop. You
can use the Tab button on the horizontal ruler to switch between the
available tabs.
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Tab Stop Purpose

Aligns text to the left of the tab stop

Aligns text to the right of the tab stop 

Centers text on the tab stop                 

Aligns numbers on the decimal point

Inserts a vertical bar at the tab stop

Tab Stops

Setting Paragraph
Tabs

Create and Clear a Tab Stop

Select one or more paragraphs in
which you want to set a tab stop.

Click the Tab button on the
horizontal ruler until it shows the
type of tab stop you want.

Click the ruler where you want to
set the tab stop.

If necessary, drag the tab stop to
position it where you want.

To display a numerical
measurement in the ruler where
the tab is placed, press and hold
Alt as you drag.

To clear a tab stop, drag it off the
ruler.
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Did You Know?
You can view formatting marks.
Sometimes it’s hard to see the number
of spaces or tabs between words. You
can change the view to display format-
ting marks, a period for space and an
arrow for tabs. Click the Home tab, and
then click the Show/Hide ¶ button to
toggle on and off. Click the File tab,
click Options, click Display, select the
formatting mark check boxes you want
to view, and then click OK.



Quickly indent lines of text to precise locations from the left or right
margin with the horizontal ruler. Indent the first line of a paragraph
(called a first-line indent) as books do to distinguish paragraphs. Indent
the second and subsequent lines of a paragraph from the left margin
(called a hanging indent) to create a properly formatted bibliography.
Indent the entire paragraph any amount from the left and right margins
(called left indents and right indents) to separate quoted passages. 
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Setting Paragraph
Indents

Indent Paragraph Lines
Precisely

Click the View Ruler button to
display the Ruler.

Click the paragraph or select
multiple paragraphs to indent:

◆ To change the left indent of the
first line, drag the First-line
Indent marker.

◆ To change the indent of the
second and subsequent lines,
drag the Hanging Indent
marker.

◆ To change the left indent for all
lines, drag the Left Indent
marker.

◆ To change the right indent for
all lines, drag the Right Indent
marker.

As you drag a marker, the
dotted guideline helps you
accurately position the indent.
You can also press and hold Alt
to see a measurement in the
ruler.

2

1

1

Right Indent
marker

First-line Indent
marker

Hanging Indent  marker

Left Indent
marker

Current indent settings are 
for this paragraph

First-line indent

Hanging indent

Did You Know?
You can indent using the Tab key. You
can indent the first line of a paragraph
by clicking at the beginning of the
paragraph, and then pressing Tab. You
can indent the entire paragraph by
selecting it, and then pressing Tab.
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Indent a Paragraph 

Click the paragraph, or select
multiple paragraphs to indent. 

Click the Home tab.

Click the Increase Indent button or
Decrease Indent button to move
the paragraph right or left one-half
inch.

Set Indentation Using the 
Tab Key

Click the File tab, and then click
Options.

In the left pane, click Proofing, and
then click AutoCorrect Options.

Click the AutoFormat As You Type
tab.

Select the Set left- and first-indent
with tabs and backspaces check
box.

Click OK.5
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Did You Know?
You can add line numbers to a docu-
ment or page. Click the Page Layout
tab, click the Line Numbers button, and
then click Continuous, Restart Each
Page, Restart Each Section, Suppress
For Current Paragraph, or Line
Numbering Options.
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The best way to draw attention to a list is to format the items with bul-
lets or numbers. You can even create multi-level lists. For different
emphasis, change any bullet or number style to one of Word’s many
predefined formats. For example, switch round bullets to check boxes
or Roman numerals to lowercase letters. You can also insert a picture
as a bullet or customize the numbering list style—including fixed-digits,
such as 001, 002, etc. (New!). If you move, insert, or delete items in a
numbered list, Word sequentially renumbers the list for you.

Creating Bulleted 
and Numbered Lists

Create a Bulleted List

Click where you want to create a
bulleted list.

Click the Home tab.

Click the Bullets button arrow, and
then select a bullet style.

Type the first item in your list, and
then press Enter.

Type the next item in your list, and
then press Enter.

Click the Bullets button, or press
Enter again to end the list. 

Create a Numbered List

Click where you want to create a
numbered list.

Click the Home tab.

Click the Numbering button arrow,
and then select a numbering style.

Type the first item in your list, and
then press Enter.

Type the next item in your list, and
then press Enter.

Click the Numbering button, or
press Enter again to end the list.

6

5

4

3

2

1

6

5

4

3

2

1
342 1

342 1



Chapter 3 Formatting Documents 81

Change Bullet or Number Styles

Select the list, and then click the
Home tab.

Click the Bullets or Numbering
button arrow.

Click a predefined format, or click
Define New Bullet or Define New
Number Format.

Select the appropriate options: 

◆ Bullet. Click Symbol, Picture, or
Font, and then select the
picture you want.

◆ Number. Select a numbering
style (New!), font, and format. 

Specify the alignment and any
other formatting you want. 

Click OK.

Create a Multi-Level Bulleted 
or Numbered List

Start the list as usual.

Press Tab to indent a line to the
next level bullet or number, type
the item, and then press Enter to
insert the next bullet or number.

Press Shift+Tab to return to the
previous level bullet or number.

To format the multi-level list, select
the list, click the Multi-Level List
button on the Home tab, and then
select a format.
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Did You Know?
You can quickly create a numbered
list. Click to place the insertion point at
the beginning of a line, type 1., press
the Spacebar, type the first item, and
then press Enter. Press Enter or
Backspace to end the list.

4

6

5

Number stylesBullet styles
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To enhance the appearance of the text in a paragraph, you can quickly
add a border and shading to selected text. When you add a border, you
can specify what sides you want to include or exclude. For example,
you can add a border on just the top and the bottom and leave the
sides open. Shading colors the background behind the selected text or
paragraph. If you want to customize borders and shading by changing
line style, color, and width preferences, you can make changes in the
Borders and Shading dialog box.

Applying Borders
and Shading

Apply a Border

Select the paragraph text you
want to format.

Click the Home tab.

Click the Borders and Shading
button arrow, and then click to
select the border commands to
add or remove a border. 

Apply Paragraph Shading

Select the paragraph text you
want to format.

Click the Home tab.

Click the Shading button arrow,
and then click to select the
shading color you want to apply to
the selected text.

3

2

1

3

2

1
2 31

2 1 3

Border options
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Apply Paragraph Shading and
Borders

Select the paragraph text you
want to format.

Click the Home tab.

Click the Borders and Shading
button arrow, and then click
Borders and Shading.

Click the Borders tab.

Click to select the type of Setting
you want for your border.

Click to select the type of Style.

Apply any other options you want.

Look in the preview box to see the
new border.

Click the Shading tab.

Click to select the shading fill color
you want to apply to your table.

Apply any other options you want.

Look in the preview box to see the
new shading color.

Click OK.13
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If you have confidential information in a document or text that you don’t
want others to see, you can hide the text. When you hide text, you
can’t view or print the text unless you select the Hidden Text option in
the Options dialog box. When you display or print hidden text, the char-
acters appear with a dotted lined underneath. Hiding text does not pro-
tect your text from being seen, but it does conceal it from others.

Hiding Text

Hide or Unhide Text

Select the text you want to hide or
the hidden text.

Click the Home tab, and then click
the Font Dialog Box Launcher.

Click the Font tab.

Select or clear the Hidden check
box.

Click OK.

Display or Print Hidden Text

Click the File tab, and then click
Options.

In the left pane, click Display.

Select the Hidden text check box.

Select the Print hidden text check
box.

Click OK.5
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Index

A
Access

inserting Access data in documents, 372
mail merge, importing data for, 251
merging with documents, 372-373

Accessibility Checker, 27
Acrobat Reader, 376
action items for meetings, 431
Actions

changing options, 58-59
embedding, 391
inserting information with, 58-59
managing, 403
showing, 382
XML properties, saving as, 390

ActiveX controls, 328, 401
flash movies, playing, 427
harmful attacks and, 326-327
inserting, 422
list of, 424
properties, setting, 425
security alerts, 423
security options, 333
VBA code, adding, 426

Ad-aware, Lavasoft, 326
add-ins, 328, 401. See also COM add-ins

harmful attacks and, 326-327
loading/unloading, 352, 404-405
managing installed add-ins, 403
security alerts, dealing with, 405
setting security options, 332
user interface errors, showing, 392
viewing installed add-ins, 402

adding/removing. See also deleting
borders, 174-175
features, 32
Quick Access Toolbar, items from, 7

shading, 174-175
Status bar, items on, 9
watermarks, 172-173

Address book for mailing labels, 266
addresses

Company Address Quick Part, 226
default mailing address, 392
form letter envelopes, addressing, 266
URLs (Uniform Resource Locators), 297
Web addresses, 297

adjustment handles for shapes, 182-183
Adobe Systems

Acrobat Control for ActiveX, 424
Acrobat Reader, 376
Photoshop, 123
Type Manager fonts, 68

adware, 326
agenda for meetings, 431
alerts. See Groove; security alerts
aliases in XML schemas, 366
Align commands, 194
Align Group for SmartArt graphics 

shapes, 138-139
aligning. See also objects

columns, text in, 176
of equations, 244
of existing text, 74
paragraph alignment, changing, 74
tables, cells in, 152

all caps text, 66
alternative text, 27
animated GIFs, 110
animation

animated GIFs, 110
feedback with, 392
in organization charts, 142
showing, 382

Anonymous FTP sites, 307
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antivirus software, 327
Apply button, 8
Arabic, support for, 280
arrows in dialog boxes, 8
articles, text boxes for, 180
ascending sort, 147
ASCII symbols, 246
attachments

Full Screen Reading view
disabling attachments in, 18
opening in, 380

harmful attacks and, 326-327
meeting attachments, 431

Author Quick Part, 226
AutoComplete, 48, 386
AutoCorrect, 60-61

example of changes, 61
spell-checking with, 270-271

AutoCorrect Exceptions dialog box, 60
AutoFit for tables, 153
AutoFormat

for long documents, 208-209
revising documents with, 208

Automated Safe mode, 338-339
automatic links, updating, 392
Automatic Updates, 327
AutoRecover, 31
AutoShape, 397
AutoText

printing, 292
working with, 228-229

averaging values in table cells, 158
Avery Standard 1529 labels, 262-263

B
background

printing in, 385
repagination, enabling, 392
Web pages, opening, 294

backgrounds
page backgrounds, adding, 174-175
print options, 384
removing picture, 126
as shape fills, 188
WordArt fill and, 128

Backspace key, 50

bulleted or numbered list, ending, 61
Backstage view, 3, 5
balloons. See sharing documents
Banded Row or Banded Column option, 156
bibliographies

citation and source, adding, 236
indents, setting, 78
placeholders, adding, 237

bitmap images. See BMP files
black and white color option, 122
blank documents, creating, 36
Blog Accounts dialog box, 311
Blogger, 308-310, 311
blogs

creating postings, 308-309
document contents, creating blog, 

308-309
existing posting, opening, 310
managing accounts, 311

BMP files
cropping bitmapped pictures, 124-125
modifying pictures, 123
resizing images, 119

boilerplate for mail merge, 250
boldfacing

in index, 220
long documents, formatting in, 208
shape text, 187
text, 64, 66

bookmarks
creating, 238
for indexes, 220-221
navigating to, 238-239
showing, 382

borders. See also paragraphs
adding/removing, 174-175

applying, 82-83
edge, moving, 10
pictures, adding to, 116
tables, applying to, 155

Borders and Shading dialog box, 82-83
bottom-aligning objects, 194-195
bound document, preparing for, 215
breaks. See also page breaks

column breaks, inserting, 176-177
brightness of pictures, 

changing, 121, 398-399
Bring Forward for objects, 198



Index 483

Bring to Front
for objects, 198
SmartArt graphics shapes, 138-139

browsers
documents, opening, 12, 295
viewing Web pages from, 297

browsing in documents, 47
Building Block gallery form controls, 420
Building Blocks Organizer, 227
bulleted lists

copying/pasting options, 387
creating, 61, 80
multi-level lists, creating, 81
options, 386
style of bullets, changing, 80-81

buttons. See also specific types
in dialog boxes, 8

C
Cancel button, 8
capitalization

AutoCorrect changes, 61
drop caps, 170-171
Match Case option, 70
uppercase text, 66

Caps Lock button, 9
captions, creating, 240
case of text

changing, 66
Match Case option, 70

CD-ROM, inserting pictures from, 111
cells. See tables
center-alignment

of equations, 244
objects, 194-195
of text, 74

centered as group alignment of 
equations, 244

certification authority (CA), 322
Change Color button, 142
Character Code box, 246
characters. See also symbols

drop caps, 170-171
finding and replacing special 

characters, 71
inserting special characters, 247

spacing, changing, 68, 388
styles, 92
wildcards, finding and replacing with, 73

charts. See also organization charts
axis titles, changing, 165
bar charts, formatting, 166
creating, 159
custom chart templates, creating, 168
data labels, changing, 165
deleting, 162
drop lines in, 166
editing data in, 167
entering data in worksheets, 161
entire chart, changing type for, 162
error bars in, 166
gridlines, showing/hiding, 165
high-low lines in, 166
inserting, 159
layout, changing, 163
legends, changing, 165
line charts, formatting, 166
opening chart data, 160
saving chart templates, 168
series lines in, 166
showing/hiding elements, 164
style, changing, 163
titles, changing, 164
trendlines, options for, 166
type, changing, 162
up/down bars in, 166
viewing chart data, 160
wrapping text around, 178-179

Check Box button, 424
check boxes, 8

Check Office documents that are from or
link to suspicious Web sites check
box, 327, 336

Check for Updates button, 33, 312
Check Office documents that are from or

link to suspicious Web sites check
box, 327, 336

Chinese, support for, 280
circles, drawing, 182
citations, adding, 236-237
class modules in VBA, 407
Classic style set, 90
Click-And-Type text, 74



484 Index

clip art, 109
cropping, 124-125
locating and inserting, 110
recoloring, 122-123
shapes, applying picture fills to, 190

Clip Art task pane, 110
Clip Organizer, 110, 169
Clipboard

copying text to, 52-53
options, changing, 52
storing text on, 50

Close button, 42
closing

documents, 34
task window, 10
window panes, 10

code. See VBA (Visual Basic for
Applications)

colors. See also font colors; gradient fills;
themes

comment colors, setting, 350
menus, adding to, 99
for organization charts, 142
page colors, adding, 174-175
picture color, editing, 398-399
properties of, 103
recoloring pictures, 122-123
schemes, selecting, 380
shapes, adding color fills to, 188-189
SmartArt graphic colors, changing, 137
3-D colors to shapes, adding, 193
Web page colors, changing, 295

columns and rows. See also charts; tables
breaks, inserting, 176-177
mail merge data, displaying, 255
modifying text columns, 176-177
newspaper-style columns, 176-177

COM add-ins, 403. See also ActiveX 
controls

loading/unloading, 404-405
Combo Box button, 424
combo box form controls, 420
command buttons, 4, 424
commands

accessing commands not on Ribbon, 396
choosing, 5

comments
all comments, deleting, 346-347

colors, setting, 350
editing, 346
handwritten comments, inserting, 345
inserting, 344
reading comments, 346
responding to, 345
specific reviewer, deleting comments

from, 346-347
voice comments, inserting, 344

Company Address Quick Part, 226
Company E-mail Quick Part, 226
Company Quick Part, 226
comparing documents, 351
Compatibility Checker, 26
compatibility mode

converting existing documents, 15
diagnostics, 32
options, setting, 393
saving documents, 22

compressed zip package, 421
compressing pictures, 120
connection status help, 21
contact us, Microsoft, 312
contacts. See Groove
content controls, 420-421
content filtering, 337
contextual spelling, 274-275
contextual tabs, 4
contrast in pictures, changing, 121, 398-399
converting existing documents, 15
copy, opening document as, 12
copying. See also drag-and-drop; text

Excel, data from, 368-369
hyperlinks, 302
importing/exporting with, 360-361
macros, 415
options, changing, 387
templates, functionality between,352-353
window contents, 111

copyright symbols, 68
cover pages for long documents, 223
cropping

pictures, 124-125, 398-399
showing crop marks, 382

cross references
in documents, 214
in index, 220

CSS (Cascading Style Sheets), 306
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custom dictionaries, 272-273
Custom Dictionaries dialog box, 272-273
Customize Quick Access Toolbar list arrow, 6
customizing, 379. See also themes

advanced document properties, 28
caption labels, 240
drop caps, 170-171
hyphens, 57
Installed Templates, 88
line numbering options, 243
margins, 282-283
picture fills for shapes, 190
Quick Access Toolbar, 7
texture fills for shapes, 190
theme colors, 102-103
watermarks, 172-173

cutting options, 387
cycle graphic type, 132

D
damaged files, opening, 12
data documents, 249

creating, 253
editing, 254
identifying, 251

data labels, changing, 165
data series, 159
databases. See Excel
Date Picker, 420
dates and times

in headers or footers, 210
inserting in documents, 212-213

Debug toolbar, 414
debugging macros, 410, 414
decimals, displaying table numbers as, 158
Delete key, 50
deleting. See also Groove; tables; themes

AutoText entry, 229
borders from pictures, 116
charts, 162
column breaks, 177
columns, 176
comments, 346-347
dialog boxes, files in, 12
digital signatures, 323
encrypted files, 317

footnotes and endnotes, 233
guides, 197
hard page breaks, 286
headers or footers, 210
hyperlinks, 302-303
hyphens, 57
with keyboard, 50
macros, 413
page numbers, 212
password protection, 319
Quick Access Toolbar, items from, 7
section breaks, 286-287
shapes, 182
SmartArt graphic shapes, 135
Status bar, items on, 9
styles, 89
tables of contents, 219
text, 50-51
theme colors, 103
watermarks, 172-173
XML tags, 365

descending sort, 147
Design Mode. See ActiveX controls
desktop publishing

backgrounds, 174-175
colors, adding, 174-175
columns, working with, 176-177
drop caps, adding, 170-171
text boxes, working with, 180-181
watermarks, 172-173
wrapping text around object, 178-179

destination files, 358, 362
Developer tab

ActiveX controls on, 422
options, setting, 409
showing, 409

diagnosing/repairing problems, 32
Dialog Box Launchers, 3, 8
dialog boxes

deleting files in, 12
options, choosing, 8
renaming files in, 12

dictionaries
custom dictionaries, 272-273
exclusion dictionaries, 272-273
familiar words, adding, 271
for spell-checking, 270
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digital signatures, 322-323
macro projects, adding to, 416
Status bar, checking with, 9
XPS support for, 376

direction
shapes, 3-D effects on, 193
tables, changing text direction in, 152
text box, changing text direction in, 180
WordArt text, changing direction of, 131

disk diagnostics, 32
Distinctive style set, 90
distributing objects, 194
DOCM files, 25
Document Information Panel, 28

for final documents, 340
selecting template, 428

Document Inspector, 314-315
Document Library, 456
Document Map in Full Screen Reading

view, 18-19
Document Properties for Quick 

Parts, 226-227
documents, 1, 238. See also comments; for-

matting; grammar-checking; long doc-
uments; macros; mail merge; metada-
ta; printing; read-only documents;
saving; sharing documents; spell-
checking; technical documents; text;
themes

Access database in, 372-373
AutoText, working with, 228-229
bibliographies, 236
blank document, creating, 36
bound document, preparing for, 215
browsing through, 47
captions, creating, 240
closing, 34
Compatibility Checker, 26
converting existing documents, 15
cover pages for, 223
cross references, inserting, 214
digital signatures, 322-323
Document Inspector, 314-315
double-sided documents, printing, 290
Excel worksheets, inserting, 368-369
existing document, opening, 12-13
final documents, 340
in Full Screen Reading view, 18-19
headers and footers in, 210-211

hyphens, inserting, 56-57
inconsistent formatting, checking 

for, 268-269
inspecting documents, 314-315
letters, creating, 39
lines, numbering, 79, 242-243
memos, creating, 39
merging documents, 351
multiple-author documents, 

creating, 206-207
multiple documents, working with, 44-45
new documents

blank documents, creating, 36
existing document, creating from, 37
templates, creating from, 38

Office Web App, creating, 485
page numbers, inserting, 212-213
paging through, 47
part of document, allowing changes, 321
passwords for, 318-319
PowerPoint slides, creating, 370-371
previewing, 288
proofing, 270-271
properties, viewing, 28
Quick Parts, inserting, 226
readability of documents, 271
reading, 18-19
recovering documents, 30-31
restricting formatting/editing, 320-321
scrolling in, 47
selecting text in, 48-49
single file Web page, saving document

as, 304-305
subdocuments, inserting, 206-207
symbols, inserting, 246-247
tables in slide, embedding, 370-371
tables of contents for, 218-219
tables of figures, 241
templates, creating with, 38
in Thumbnail pane, 18-19
two-sided documents, printing, 290
views, changing, 16-17
Web page, opening as, 294-295
word count statistics, 222
zooming view, 29

DOCX files. See documents
double-sided documents, printing, 290
double strikethrough text, 66
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Download.com, 327
downloading. See also security

Acrobat Reader, 376
add-ins, 402
checking files on, 327
FTP (File Transfer Protocol) files, 307
Office program Viewer, 12
templates, 38
XPS file viewers, 377

draft quality printing, 385
Draft view, 16-17
drag-and-drop

options, 386
SmartArt graphics, 132-133
for text, 50-51

drawings
print options, 384
showing on screen, 382

drop caps, 170-171
drop down list form controls, 420
drop lines in charts, 166
duplex printing, 290, 385
duplicate words, eliminating, 270

E
e-mail. See also attachments

Company E-mail Quick Part, 226
document for review, sending, 354-355
FTP (File Transfer Protocol) and, 307
hyperlinks for sending, 299
mail merge to, 260-261
PDF files, sending, 354-355
spam, 326
XPS files, sending, 354-355

Edit Data Source dialog box, 167
Edit Points command, 185
editing.

AutoCorrect entries, 61
changing options, 268, 386
chart data, 167
comments in shared documents, 346
data documents, 254
embedded objects, 362
exclusion dictionaries, 271-272
final documents, 340
footnotes and endnotes, 233

freeforms, 185
hyperlinks, 302
macros, 415
mail merge fields, 257
with Picture Manager, 398-399
in Print Preview, 288
properties of document, 28
restricting formatting/editing, 320-321
text, 50-51
theme colors, 103
WordArt text, 127
XML data files, 365

eFax, 356
effects. See also shadow effects; 3-D effects

pictures, adding to, 117
theme effects, choosing, 106
WordArt, applying to, 130

Elegant style set, 90
em/en dashes, 61, 208
embedding, 358. See also charts

Excel, data from, 368-369
existing objects, 363
fonts on saving documents, 390-391
linguistic data, 391
new objects, 362-363
save options, 390-391
slides, Word tables in, 370-371

emboss text, 66
en/em-dashes, 61, 208
encryption of files, 316-317
endnotes. See footnotes and endnotes
engrave text, 66
Enhanced ScreenTips, 278
envelopes. See form letters
Equations gallery, 244
equations in technical documents, 244-245
error bars in, 166
Esc key for format painting, 98
European languages, support for, 280
Excel. See also charts

document, inserting worksheets 
in, 368-369

importing
data, 368-369
worksheets, 360

mail merge, importing data for, 251
opening, 14
picture, importing data as, 369



488 Index

exclusion dictionaries, 272-273
existing document, opening, 12-13
exiting

Word, 34
Expand Chat button, 430
exporting. See importing/exporting
expressions, VBA, 406

F
Fancy style set, 90
faxing

Internet fax, sending document by, 356
feedback options, setting, 392
fields. See also mail merge

caption fields, adding, 240
navigating in document with, 217
Quick Part building blocks, 226-227

figures
cross references to, 214
tables of figures, 241

file block settings, 328, 330-331
file extensions, displaying, 15
file formats

list of, 25
saving documents in, 24-25

File tab, 3, 5
files. See also documents

default locations, changing, 392
encryption, 316-317
non-Word format files, opening, 14
pictures from file, inserting, 111
WordArt text, applying to, 128-129

Files tool, Groove, 454
FileZ, 327
Fill Color button, 99
fills. See also shapes

gradient, 191
shapes, adding color fills to, 188-189
tables, applying to, 155

filtering
content filtering, 337
mail merge, records for, 255

FIM-A codes, 266
Find and Replace dialog box

Match Case option, 70
specific page in long document, 216

Find command, 54-55
finding and replacing. See also formatting

items, finding, 70
locations, finding, 70
text, 54-55

Firefox, 430-431, 438
Firewall. See Windows Firewall
first-line indents, 78
flash movies, playing, 427
Flesch-Kincaid Grade Level score, 271
Flesch Reading Ease score, 271
flipping

objects, 199
pictures, 398-399

floating tables, 144
Font Color button, 99

last font color, displaying, 105
font colors

last font color, displaying, 105
shape text, adding to, 187
text, 64

Font dialog box, 68
for shape text, 187

fonts. See also font colors
changing fonts, 64
changing options, 388
CSS (Cascading Style Sheets) for Web

pages, 306
deleting theme fonts, 106
draft fonts, using, 382
for drop caps, 170-171
embedding fonts on saving, 390-391
for indexes, 221
for letters or memos, 39
point size, 65
printer fonts, 65
shapes, text in, 187
symbols, availability of, 246
theme fonts, choosing, 104-105
TrueType fonts, 65
Web page font, changing, 295

footers. See headers and footers
footnotes and endnotes

continuation notice, adding, 235
converting notes to, 235
creating, 232
editing, 233
formatting, 234-235
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navigating in document by, 217
renumbering, 234

foreign languages, 256
adding languages to program, 280
keyboard, enabling, 277, 280
proofing, 276-277
support for, 256
thesaurus for, 275
translating text to, 278-279

form controls, 420-421, 422
form letters, 249

common words, use of, 257
creating, 256-257
envelopes

addressing, 266
creating, 264-265

extra spaces, 257
mailing labels, 266
personalizing, 259
printing, 259

Formal style set, 90
Format Cells dialog box, 64-65
Format Painter, 98
Format Shape dialog box, 188, 191
formatting. See also aligning; charts; fonts;

SmartArt graphics; styles; tables
applying, 67
automatic formatting for long 

documents, 208-209
bar charts, 166
case of text, changing, 66
clearing, 67, 69
comparing text formatting, 97
effects, 66-67
for emphasis, 66-67
finding and replacing, 69-70

special formatting, 72-73
footnotes and endnotes, 234-235
graphic formats, adding, 111
inconsistent formatting, checking 

for, 268-269
in index, 220
line charts, 166
line numbers, adding, 79
line spacing, changing, 75
long documents, automatic formatting

for, 208-209
marks, viewing, 77

quickly formatting text, 64-65
restricting formatting/editing, 320-321
shapes, text in, 187
similar formatting, selecting text with, 69
SmartArt shapes, 188
WordArt text, 128-129

forms. See also Groove
controls, adding, 420
field properties, changing, 421
security for, 421

Formula dialog box, 158
FoxPro, 251
frames, hyperlinks between, 300-301
freeforms

converting shapes to, 185
defined, 169
drawing, 185
modifying, 185

French, translating text to, 278
FTP (File Transfer Protocol), 307
Full Screen Reading view, 16-17. See also

attachments
Document Map, displaying, 18-19

function procedures, VBA, 407

G
galleries, 3
getting started, 312
GIF files, 123
glow

in organization charts, 142
pictures, adding to, 117
in text, 66-67

Go To dialog box
bookmarks, selecting, 238
navigating in document with, 217

gradient fills, 191
grammar-checking

settings, changing, 275
showing/hiding errors, 274

grammar-checking documents, 270-271
graphical lists, 132
graphics. See also clip art; pictures; shapes;

SmartArt graphics; WordArt
AutoText, working with, 228-229
navigating in document by, 217
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graphics (continued)
SmartArt, graphic layouts, 132, 140
wrapping text around, 178-179

grayscale color option, 122
Grid and Guides dialog box, 196-197
gridlines

chart gridlines, showing/hiding, 165
objects, aligning, 196-197
showing/hiding, 197
table gridlines, showing/hiding, 148

Groove, 452-455
alerts, 454
creating workspace, 452-453
deleting

workspace, 452
inviting users to, 455
launching, 452
Microsoft SharePoint Workspaces, 

452-455
permissions, changing, 455
roles in, 455
sharing files in, 454
starting, 452
tools, Documents, managing, 454

grouping/ungrouping
objects, 200-201
tables, 200
tabs, controls on, 4

guides
deleting, 197
objects, aligning, 196-197
showing/hiding, 197

gutters, setting up, 215, 282-283

H
hackers, 316
handwritten comments, inserting, 345
hanging indents, 78
hard page breaks, inserting/deleting, 286
hardware graphics acceleration, 383
headers and footers

for different pages, 211
in long documents, 210-211
Quick Parts for, 226

headings

cross references to, 214
navigating in document by, 217
in outlines, 204
text boxes for, 180

Hebrew, support for, 280
height

of drop caps, 170-171
of rows, 150-151

help
connection status help, 21
Help Viewer, 20-21
Tech Support, 33

Help Viewer, 20-21
Web page appearance, changing, 295

hidden text. See text
hiding. See showing/hiding
hierarchy graphic type, 132. See also

organization charts
high-low lines in charts, 166
highlighting

text, 66
homographs, 326
horizontal ruler, 76
HSL colors, 99, 102-103
HTM/HTML files, 25
HTML (Hypertext Markup Language), 293.

See also Web pages
pixels for HTML features, showing, 383
hue, 103
hyperlinks, 359

between documents, inserting, 299
deleting, 302-303
within document, inserting, 298
e-mail, sending, 299
editing, 302
frames, creating between, 300-301
ScreenTips for, 303
in table of contents, 218
theme colors, 100
using, 302

hyphens, 56-57
long documents, formatting in, 208
setting hyphenation options, 76
words, hyphenating, 271

I
Image button, 424
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importing/exporting, 358. See also Excel;
mail merge

with copy and paste, 360-361
files, importing, 361
other programs, exporting to, 361
with Picture Manager, 398
inconsistent formatting, checking 

for, 268-269
indents

paragraph indents, setting, 78-79
with Tab key, 78-79

indexes, 220-221
multiple page entries, 221

Insert Hyperlink dialog box, 300-301
inspecting documents, 314-315
Installed Templates, 88
InterFAX, 356
international languages. See foreign

languages
Internet. See also blogs; browsers; hyper-

links; Microsoft Office.com Online;
Web pages

fax, sending document by, 356
FTP (File Transfer Protocol), 307
parental controls, setting, 336-337
updates on, 33

Internet Explorer, 430-431, 438
Internet Properties dialog box, 295
inviting users to Groove, 455
italicizing

in index, 220
long documents, formatting in, 208
shape text, 187
text, 64, 66

J
Japanese, support for, 280
JPG files, 123
justification

of equations, 244
of text, 74

K
kerning, 68
keyboard

correcting typing with, 50
foreign languages, accommodating, 280
grid settings, overriding, 197

keyboard language, 277
KeyTips, 4
Korean, support for, 280

L
Label button, 424
labels

captions, custom labels for, 240
mail merge, creating with, 262-263
mailing labels, 266

landscape orientation. See orientation
languages. See foreign languages
Lavasoft Ad-aware, 326
Layout Styles groups, 142
layouts. See also page setup

for charts, 163
for organization charts, 142
SmartArt graphic layout, changing, 

132, 137
leaders

in table of contents, 218
in tables of figures, 241

left-alignment
of equations, 244
of objects, 194-195
of text, 74

left indents, 78
Legacy tools, 420
legends in charts, 165
letters. See also form letters; mail merge

creating, 39
lighting 3-D effects with shapes, 193
Linear equation display, 244
lines

defined, 169
document lines, numbering, 79, 242-243
numbers, adding, 79, 242-243
spacing, changing, 75
tracking changes options, 350

linguistic data, embedding, 391
Linked Notes, from OneNote

creating, in Word, 375
opening, in Word, 375
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links/linking, 358. See also hyperlinks
charts to worksheet cells, 164
existing objects, 363
files in Word, 360
with Paste Special, 362
printing, updating linked data 

before, 384
text boxes, linking, 180-181
updating links, 363

List Box button, 424
list boxes, 8
lists, 3

graphical lists, 132
table lists, sorting, 147

live preview, 4
enabling, 380
Paste Options, 52
theme fonts, 104

loading/unloading
add-ins, 352, 404-405
templates, 352

locking/unlocking master documents, 207
logos

on letters or memos, 39
as watermarks, 172-173

long documents, 203, 238. See also techni-
cal documents

AutoFormat for, 208-209
automatic formatting for, 208-209
AutoText, working with, 228-229
bibliographies, 236
bound document, preparing for, 215
browse object, navigating with, 217
captions, creating, 240
cover page, adding, 223
cross references, inserting, 214
gutters, setting, 215
headers and footers in, 210-211
indexes, creating, 220-221
lines, numbering, 242-243
multiple-author documents, 

creating, 206-207
navigating

with browse object, 217
to specific page, 216

numbering lines in, 242-243
outlines, creating, 204-205
page numbers, inserting, 212-213

searching in, 216
specific page, moving to, 216
subdocuments, inserting, 206-207
symbols, inserting, 246-247
tables of contents for, 218-219
tables of figures, 241
word count statistics, 222

Lotus 1-2-3 files, 14
lowercase text, 66
luminosity, 103

M
Macro Recording and Playback, 9
macros, 328, 401

copying to other documents, 415
creating, 412
debugging, 410, 414
deleting, 413
description of, 410
digital signatures, adding, 416
editing, 415
harmful attacks and, 326-327
opening documents with, 419
Personal Macro document, 410
Quick Access Toolbar, adding to, 417
recording, 411
running, 413
saving documents with, 418
security alerts with, 419
self-signing certificates, creating, 416
setting security options, 334
stopping, 413

mail merge, 249. See also data documents;
form letters

with Access database records, 372-373
common words, use of, 257
database, importing data from, 251
to e-mail, 260-261
excluding recipients from, 258
extra spaces, 257
filtering records, 255
labels, creating, 262-263
Outlook, importing data from, 252
personalizing, 259
previewing, 258
printing, 259
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sorting records, 255
starting Mail Merge wizard, 250

Mail Merge wizard, 249. See also data
documents

Outlook, importing data from, 252
starting, 250

Mailing tab, 249
maintenance, performing, 32
Manage Source dialog box, 236-237
Manage Styles dialog box, 94-95
Manager Quick Part, 226
Manual Duplex option, 290
margins

for balloons, 350
options, changing, 388-389
Page Setup, creating with, 282-283
quickly selecting standard margins, 283
tables, changing cell margins in, 152-153
visually adjusting, 282

Mark as Final command, 340
markup

printing, 292
master documents, creating, 206-207
mathematical symbols, 244
matrix graphic type, 132
Maximize button, 42
maximizing/minimizing

Ribbon, 4, 6
windows, 42

McAfee antivirus software, 327
measurement units, 383
Memo wizard, 39
memory diagnostics, 32
memos, creating, 39
menus. See also shortcut menus

colors, adding, 99
File tab, 5

merge fields, 249
merging. See also mail merge

Access database records, 372-373
cells in tables, 150
documents, 351

Message Bar, 328
changing security options, 335
macros in, 334, 416

messages. See also e-mail
metadata, 314

customizing, 394

viewing, 28
methods, VBA, 406
MHT/MHTML files, 25

Microsoft. See also Excel; Outlook;
PowerPoint

Customer Experience Improvement
(CEIP) program, 328

Forms 2.0 controls, 424
InfoPath controls, 424, 428
Paint, 123
Tech Support, 33
Update Web site, 33
Web Browser, 424
Works, opening, 14

Microsoft Office Online, Office.com
accessing, 312
Help Viewer, 20-21
templates, choosing, 38
themes, searching for, 101

Microsoft Office Picture, 379
Microsoft SharePoint. See Groove
Microsoft Organization Chart. See organiza-

tion charts
Microsoft Outlook. See also e-mail

Internet Fax, sending document by, 356
Microsoft Window SharePoint Services, 308
Microsoft Windows Metafile, 110
middle-aligning objects, 194-195
Mini-Toolbar

commands on, 5
formatting actions, 64
showing, 380

Mini Translator, 278-279
Minimize button, 42
minimizing. See maximizing/minimizing
Modern style set, 90
modules in VBA, 407
motion clips, 110
mouse, resizing windows with, 42
movies, playing, 427
moving. See also navigating

Clipboard, text in, 52
hyperlinks, 302
Quick Access Toolbar, 6
in tables, 146
windows, 42
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multiple-author documents, 
creating, 206-207

multiple documents, working with, 44-45
My Data Sources folder, 251
My Templates, 86
MyFax, 356

N
names. See also renaming

dialog boxes, files in, 12
in headers or footers, 210

navigating. See also long documents
to bookmarks, 238-239

Navigation pane
browsing, 46
displaying, 18-19
finding and replacing, 54
headings and page view, 19
searching, 46

nested tables, 144, 153
New dialog box, 37

templates, choosing, 38
new document, creating, 36
New Document dialog box templates, 88
newspaper-style columns, 176-177
nonbreaking hyphens, 56-57
Normal global template, 352
Normal view, 243
notebook (OneNote)

Office Web App, creating, 485
notes. See also footnotes and endnotes

converting, 235
Notes pane. See footnotes and endnotes
Num Lock, 9
numbered lists

copying/pasting options, 387
creating, 61, 80
multi-level lists, creating, 81
options, 386
style of numbers, changing, 80-81

numbering. See also page numbers
customizing line numbering options, 243
document lines, 242-243

O
objects. See also embedding; shapes; VBA

(Visual Basic for Applications)
aligning, 194-195

to grids and guides, 196-197
clip art objects, 110
connecting two shapes, 198
customizing creation methods, 397
distributing objects, 194
flipping, 199
grouping/ungrouping, 200-201
hard-to-select objects, selecting, 194
hidden objects, viewing, 198
preset increments, rotating/flipping 

with, 199
rotating, 199
selecting

order, objects in, 200
with Selection pane, 194

Selection pane, selecting with, 194
stacking order, changing, 198
troubleshooting arrangement of, 201
VBA objects, 406
wrapping text around, 178-179

Office.com
accessing, 312
clip art, inserting, 110
Help Viewer, 20-21
options, 392
SmartArt graphics, 132
text boxes, 180
templates, choosing, 38
themes, searching for, 101

Office Clipboard. See Clipboard
Office program Viewer, 12
Office Web Apps

accessing documents, 437-438
browser support, 430-431
collaborating, documents with, 449-450
compare to desktop app, 436-437
creating documents, 442
downloading files, 447
file compatibility, 430
introduction, 429-430
Microsoft Silverlight, 430, 432-433
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Office Mobile, 458
opening documents, 438
preparing to use, 430
saving documents, 434-435
saving files, new name, 447-448
using, 430
Windows Live ID, 429-430, 432-433

sign-in, 433
OLE (object linking and embedding), 358.

See also ActiveX controls
OneNote

creating, in Word, 375
opening, in Word, 375

Open dialog box
default file location, changing, 13
file extensions, displaying, 15
properties, changing, 28

OpenDocument Text (ODT), 25
Open Packaging Convention, 421
opening

blog postings, 310
encrypted files, 317
existing documents, 12-13
macros, documents with, 419
non-Word format files, 14
password-protected documents, 319
Picture Manager, 398
templates, 87
Web page, document as, 294-295
XML data files, 365

OpenType
character spacing, 68

option buttons, 424
in dialog boxes, 8

optional hyphens, 56-57
organization charts

colors, changing, 142
creating, 141
dotted lines in, 142
layout, changing, 142
lines in, 142
Quick Styles for, 142

orientation
quick setup options, 40
SmartArt graphic orientation, 136

Original document status, 30
orphans, 285

Outline view, 16-17, 204-205
outlines

display, changing, 205
for long documents, 204-205
for master documents, 206-207
PowerPoint presentation, creating out-

line from, 374
shapes, applying color outline to, 189
text, 66
as you type, creating, 243

Outlining Tools group, 204-205
Outlook

mail merge, importing data for, 252
opening, 14

P
page breaks

controlling, 285
hard page breaks, inserting/deleting, 286

page covers, 226
page numbers

background repagination, enabling, 392
in headers or footers, 210
inserting in documents, 212
Status bar, checking with, 9

page setup. See also orientation
customize size options, 41
display options, setting, 381
margins, adjusting, 282-283
options, changing, 388-389
quick setup options, 40
section breaks, inserting and 

deleting, 286-287
paging in documents, 47, 217
Paint Shop Pro, 123
painting, format, 98
paper size, 284

options, changing, 388-389
paragraphs. See also desktop publishing

alignment, changing, 74
borders

adding/removing, 174-175
applying, 82-83

cross references to, 214
default paragraph text, changing, 389
drop caps, 170-171
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paragraphs (continued)
indents, setting, 78-79
marks, showing/hiding, 77
page breaks, controlling, 285
selecting, 48-49
shading

adding/removing, 174-175
applying, 82-83

smart paragraph selection, 386
styles, 92
table of contents, adding to, 218
tabs, setting, 77

parental controls, setting, 336-337
passwords

deleting password protection, 319
for documents, 318-319
with file encryption, 316-317
for FTP (File Transfer Protocol), 307
part of document, allowing changes, 321
strong passwords, using, 316
templates, protecting, 353

Paste Link in PowerPoint presentation, 374
Paste Options button, 52

live preview, 52
Paste Special

Excel worksheets, inserting, 368-369
linking with, 362

Paste Special button, 52-53
pasting

importing/exporting with, 360-361
options, changing, 387
with special results, 52-53
text, 52-53

PDF files, 25
document as PDF file, sending, 354-355
saving document as, 376

permissions
SkyDrive, Windows Live, 442
Status bar, checking with, 9

Personal Macro document, 410
personalizing form letters, 259
phishing, 326
Picture Border button, 116
Picture Effects gallery, 117
Picture Manager, 379, 398-399
Picture Quick Style Gallery, 111
Picture Shape gallery, 115

pictures. See also shapes
artistic style, 113
borders, adding, 116
brightness, changing, 121, 398-399
compressing, 120
contrast, changing, 121, 398-399
cropping pictures, 124-125, 398-399
editing, 398-399
effects, adding, 117
Excel data as picture, importing, 369
file, inserting from, 111
form controls, 420
Picture Manager, 398-399
placeholders, showing, 382
precisely resizing/scaling, 118-119
Quick Styles, adding, 111
recoloring, 122-123
removing background, 126
resetting to original state, 123
resizing, 118-119
rotating pictures, 124-125
scaling pictures, 118-119
Screen shot 

capturing, 112
inserting, 112

shapes, applying picture fills to, 190
sharpen and soften, 121
SmartArt, graphic layouts, changing,

132, 140
transparent backgrounds, setting, 122-

123
undoing changes, 399
wrapping text around, 178-179

pinning with Recent Documents list, 12-13
pixels for HTML features, showing, 383
PNG files

modifying pictures, 123
Web page option, 306

points for fonts, 65
polygons. See freeforms
Pop-up Blocker, 326
portrait orientation. See orientation
POSTNET bar code, 266
PowerPoint. See also gridlines; guides

documents, creating slides, 370-371
outline from presentation, creating, 374
themes, matching, 101
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presentation (PowerPoint)
Office Web App, creating, 485

presets
gradient fills with presets, applying, 191
rotating/flipping objects with, 199

preview boxes, 8
previewing. See also live preview

documents, 288
mail merge, 258
styles, 95
Web pages, 296-297

previous versions, showing, 12
Print command, 1
Print dialog box

Manual Duplex option, 290
previewing work in, 288

Print Layout view, 16-17, 381
background colors/images, showing, 382
ruler, displaying, 383

Print Preview, 288
Web pages in, 296-297

printer fonts, 65
printing

all of document, 289
AutoText entries, 292
displaying print options, 384
document properties, 292
double-sided documents, 290
draft quality printing, 385
duplex printing, 290, 385
form letters, 259
gutters, setting, 215
hidden text, 84, 384
key assignment, shortcuts, 292
mail merge, 259
mailing labels, 266
markup, list of, 292
options, changing, 385
pages per sheet, 291
part of document, 289
in reverse order, 385
speed, improving, 284
styles, 292
track changes, documents with, 348-349
two-sided documents, printing, 290

privacy, 328
link to Trust Center, 328

parental controls, setting, 336-337
setting options, 336-337

Privacy dialog box, 2
procedures, VBA, 407
process graphic type, 132
Professional equation display, 244
program tabs, 4
projects, VBA, 407
proofing documents, 270-271. See also

grammar-checking; spell-checking
languages, 276-277
options, changing, 274-275
thesaurus, working with, 275

properties
for ActiveX controls, 425
advanced document properties, 28
of colors, 103
document properties, viewing/editing, 28
editing document properties, 28
form field properties, changing, 421
Save As dialog box, changing with, 28
table properties, changing, 151
VBA properties, 406
XML properties, saving as, 390

protected view, 328, 330-331
public key, 322
publishing. See blogs; desktop publishing;

Web pages
pull quotes, 180

Quick Parts for, 226
pyramid graphic type, 132

Q
Quick Access Toolbar, 1, 3

add-ins, loading/unloading, 404
adding/removing items from, 7
commands not on Ribbon, 396
commands on, 5, 6
customizing, 7
macros, adding, 417
moving, 6
Quick Print button, 289
resetting, 6, 396
voice comments, inserting, 344

Quick Parts, 226-227, 420
Quick Print button, 289
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Quick Styles
artistic style, picture, 113
adding styles to, 94
for organization charts, 142
pictures, adding to, 114
resetting document to, 90
for shapes, 186
SmartArt graphics, adding to, 136
for tables, 154
templates, 89
text boxes, adding to, 186

Quick Tables, inserting, 144
quotation marks, formatting, 208

R
ragged alignment, 74
read-only documents, 318-319

marking, 340
opening, 12

readability of documents, 271
thesaurus, use of, 281

reading
comments in shared documents, 346
documents, 18-19

Reading Highlights button, 54
Recent Documents list, 12
recent documents options, 383
Recolor Picture Quick Style gallery, 122-123
recoloring pictures, 122-123
recording macros, 411
Recovered document status, 30
recovering documents, 30-31
red-eye removal, 398-399
redoing actions, 62
reflection

pictures, adding to, 117
in text, 66-67

relationship graphic type, 132
repairs. See also troubleshooting

damaged files, opening, 12
diagnosing/repairing problems, 32
maintenance, performing, 32
recovering documents, 30-31

Replace command, 54-55
replacing. See finding and replacing
replacing text as you type, 61

Research task pane
options, changing, 231, 395
topics, researching, 230
translating text with, 279

Reset Picture button, 121
resizing

bitmap images, 119
pictures, 118-119, 398-399
shapes, 182-183
split windows, 45
tables, cells in, 153
task panes, 10
Text pane, 134
Web pages, 305
window panes, 10
windows, 10, 42

Restore Down button, 42
Restrict Formatting and Editing task 

pane, 320-321
restricting formatting/editing, 320-321
Reveal Formatting task pane, 96
reverse page order printing, 385
Review pane, 342-343

comments, working with, 347
showing/hiding, 348-349

RGB colors, 99, 102-103
Ribbon, 1, 3, 4. See also Developer tab

accessing commands not on, 396
color options, 99
commands, 5

accessing commands not on, 396
choosing, 6

customizing, 7
maximizing/minimizing, 4, 6

right-alignment
of equations, 244
of objects, 194-195
of text, 74

right indents, 78
Roman numerals for footnotes and end-

notes, 234
rotating. See also 3-D effects

objects, 199
pictures, 124-125, 398-399
SmartArt graphics shapes, 138-139
WordArt text, 131

round bullets, 80
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RTF files, 25
form controls, 420
importing documents as, 360
saving documents as, 373

rulers
measurements, changing, 76
in Print Layout view, 383
showing/hiding, 76

Run dialog box in safe mode, 339

S
Safari, for Macintosh, 430-431, 438
Safe for Initialization (SFI) settings, 333
safe mode, 338-339

disabled items, viewing, 339
saturation, 103
Save Address List dialog box, 253
Save As dialog box, 22-24
Save command, 1
Save dialog box

file extensions, displaying, 15
options, accessing, 22

saving, 22-23
advanced save options, setting, 390-391
chart templates, 168
compressing pictures on, 120
Document Management Server, 

documents to, 456
Groove workspace, 452-455
macros, documents with, 418
older Word documents, 23
options, setting, 23
other formats, documents with, 24-25
PDF file, document as, 376
RTF files, documents as, 373
shapes as pictures, 111
Web pages, 304-305
XML documents, 22, 367
XPS file, document as, 377

scaling pictures, 118-119
Schedule, opening, 14
schemas. See XML (Extensible Markup

Language)
Screen shot 

capturing, 112
inserting, 112

ScreenTips
for add-ins, 402
for hyperlinks, 303
for macros, 417
shortcut keys, showing, 383
styles, selecting, 380
for themes, 101
turning on/off, 6

Scroll Bar Button, 424
scroll bars, showing, 383
scrolling in documents, 47
searching. See also finding and replacing

for exclusion dictionaries, 271-272
for help, 21
for inconsistent formatting, 269
in long documents, 216
metadata criteria, 394
for themes, 101

sections
breaks, inserting/deleting, 286-287
navigating in document by, 217

security, 313. See also passwords; security
alerts; Trust Center

digital signatures, 322-323
Document Inspector, 314-315
encryption of files, 316-317
for forms, 421
harmful attacks, avoiding, 326-327
restricting formatting/editing, 320-321

security alerts
for ActiveX controls, 423
add-in security alerts, 405
macros, alerts on opening, 419

Select Browse Object button, 217
Select Text with Similar Formatting 

command, 69
selecting. See also objects

footnotes and endnotes, 235
options, 386
similar formatting, text with, 69
style formatting, 96
table elements, 146
text, 48-49

Selection Mode, 9
Selection pane, 49, 194
self-signing certificates, creating, 416
Send Backward for objects, 198
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Send to Back
for objects, 198
SmartArt graphics shapes, 138-139

Send To Microsoft Word dialog box, 374
Send2FAX, 356
sepia color option, 122
series lines in charts, 166
Set Transparent Color command, 123
setup diagnostics, 32
shading

adding/removing, 174-175
applying, 82-83

shadow effects
pictures, adding to, 117
shape text, adding to, 187
shapes, adding to, 192
text, 64, 66
to WordArt, 130

Shadow or 3-D Effects gallery, 66-67, 130
shadow text, 66-67
Shape Effects button, 189
Shape Effects gallery, 192-193
Shape Fill color, 188-189
Shape Outline button, 116
Shape Outline color, 188-189
Shape Quick Style gallery, 186
shapes. See also freeforms; organization

charts; SmartArt graphics
adjusting, 183
applying shapes to pictures, 114
color fills, applying, 188-189, 190
connecting two shapes, 198
customizing creation methods, 397
defined, 169
deleting, 182
drawing, 182
effects, applying, 192-193
fills

color fills, applying, 188-189
gradient fills, applying, 191
picture fills, applying, 190
texture fills, applying, 190

gradient fills, applying, 191
outlines, applying, 189
Quick Styles, 186
replacing, 183
resizing, 182-183
saving shapes as pictures, 111

text and, 184, 187
as text boxes, 184
texture fills, applying, 190
transparency, applying color fill 

with, 189
of WordArt text, 129

SharePoint. See also Groove
Office Mobile, 458
Microsoft SharePoint Workspaces, 

452-453
Server

co-authoring documents, 457
opening from, 457
saving to, 456

shared folder, 452
workspaces, 452-453

SharePoint Files Tool, Groove, 452-455
sharing. See also importing/exporting; 

sharing documents
OLE (object linking and embedding), 358

sharing documents, 341. See also com-
ments; Groove; Review pane; tracking
changes

balloons
options, setting, 350
for revisions, 342-343
showing/hiding, 347

comparing documents, 351
e-mail, sending for review by, 354-355
Internet fax, sending document by, 356
Show Markup button, showing/hiding

elements with, 342-343
templates, sharing, 352-353
tracking changes, 342-343

Shockwave Flash Object ActiveX 
control, 427

shortcut menus
choosing commands from, 5
objects, grouping, 200

shortcuts
printing, 292
program shortcuts, 2
ScreenTips, showing in, 383
symbols, assigning to, 247

Show Markup button, 342-343
showing/hiding. See also gridlines; text;

Word Options
balloons, 347
chart elements, 164
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Developer tab, 409
document formatting elements, 342-343
Document Inspector viewing hidden

text, 314-315
footnotes and endnotes, 232
grammar errors, 274
Mini-Toolbar, 380
objects, 198
Review pane, 348-349
reviewers, 349
rulers, 76
Show Markup button, elements 

with, 342-343
spelling errors, 274
subdocuments, 207
table gridlines, 148
text, 84
Text pane, 134
white space, 287

side-by-side tables, 144
side-by-side windows, comparing, 44
sidebars

cross references to, 214
Quick Parts for, 226
text boxes for, 180

signature lines, adding, 324-325
signatures. See digital signatures
signing signature line, 325-326
Silverlight, 431-433
Simple style set, 90
single file Web page, saving document as,

304-305
size. See also resizing

page size options, 41
paper size, setting, 284

Size and Position dialog box, 118
cropping pictures with, 124-125

Size Dialog Box Launcher, 119
shapes, resizing, 182-183

SkyDrive
browsing folders, 437-438
creating folders, 439
deleting folders, 440
renaming folders, 440
setting folder permissions, 441

slide presentations, creating, 370-371

slider, 29
small caps text, 66
smart cursoring, 386
SmartArt graphics. See also organization

charts
adding shapes, 138-139
blank graphics, creating, 132-133
changing shapes, 138-139
colors, changing, 137
creating, 132-133
deleting shapes, 135
diagram type, changing, 132
formatting

orientation, changing, 136
Quick Style, adding, 136
shapes, 188
text, 135

graphic layouts, changing, 132, 140
layout, changing, 137
orientation, changing, 136
picture layouts, 132, 140
purposes, list of, 132
Quick Style, adding, 136
shapes, formatting, 188
text, working with, 135
Text pane

showing/hiding, 134
text, working with, 135
working with, 132-133

Snap to Grid for objects, 194-195
Snap to Shape for objects, 194-195
soft edges

in organization charts, 142
pictures, adding to, 117

soft page breaks, 286
software. See also ActiveX controls

antivirus software, 327
sorting

mail merge, records for, 255
table contents or lists, 147

sounds
with clip art, 110
feedback with, 392

source files, 358, 362
source program, 362
sources, adding, 236-237
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spacing
character spacing, changing, 68, 388
line spacing, changing, 75
WordArt text spacing, 130

spam, 326
Spanish, translating text to, 278
spell-checking, 270-271

contextual spelling, 274-275
language, 276-277
options, changing, 274-275
Word options, changing, 275
as you type, 270-271

Spin button, 424
splitter, resizing, 10
splitting

cells in tables, 150
windows, 44-45

spoofed Web sites, 326
Spotlight section, 38
spyware, 326
squares, drawing, 182
stacking order of objects, changing, 198
standard modules in VBA, 407
standard tabs, 4
starting

Mail Merge wizard, 250
Word, 2

statistics, displaying, 394
Status bar, 3

adding/removing items from, 9
word count statistics, 222

Status Quick Part, 226
strikethrough

shape text, adding to, 187
text, 64, 66

styles. See also Quick Styles; WordArt
character styles, 92
chart styles, changing, 163
clearing formatting, 89, 96
comparing text formatting, 97
custom style set, creating, 91
Format Painter, applying with, 98
list of styles, viewing, 93
managing styles, 94-95
modifying styles, 93
new styles, creating, 92
pane options, changing, 84

paragraph styles, 92
predefined style sets, 90
previewing, 95
printing, 292
quick styles, applying, 89
ScreenTip styles, selecting, 380
selecting formatting, 96
sets, changing, 90-91
table style options, changing, 156

Styles pane, 94
sub procedures, VBA, 407
subdocuments, inserting, 206-207
subscript text, 66
summaries

changing options, 394
superscript text, 66
surface of 3-D effects with shapes, 193
switching between windows, 43
Symantec antivirus software, 327
Symbol dialog box, 246
symbols

AutoCorrect changes, 61
inserting, 247
mathematical symbols, 244
technical documents, inserting, 246-247

synonyms, finding, 275
syntax for VBA code, 406

T
Tab key

indents with, 78-79
objects, selecting, 200

tab leaders. See leaders
tab stops for header/footer text, 211
Table Quick Style gallery, 154
tables, 143

adding contents of columns and 
rows, 157

additional rows or columns, 
inserting, 148-149

aligning text in cells, 152
averaging values in cells, 158
Banded Row or Banded Column 

option, 156
borders, applying, 155
clearing formatting, 154
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converting back to text, 144
creating, 144-145
custom tables, drawing, 145
decimal percentage, displaying numbers

as, 158
deleting

contents of cell, 146
rows, columns or cells, 149

direction of text, changing, 152
entering text in, 146
even distribution of columns and 

rows, 149
from existing text, 144
fills, applying, 155
floating tables, 144
height of rows, setting, 150-151
margins of cells, changing, 152-153
merging cells, 150
moving in, 146
navigating in document with, 217
nested tables, 144, 153
outlines, applying, 155
properties, changing, 151
Quick Styles, adding, 154
Quick Tables, inserting, 144
quickly creating new tables, 145
resizing cells, 153
selecting elements in, 146
showing/hiding gridlines, 148
side-by-side tables, 144
size of cells, changing, 153
slides, Word tables in, 370-371
sorting contents or lists, 147
splitting cells, 150
style options, changing, 156
summing rows and columns, 157
Total Row option for, 156
ungrouping, 200
values, calculating, 158
width of columns, setting, 149, 150-151
wrapping text around, 178-179

tables of contents, 218-219
manually creating, 219

tables of figures, 241
Tablet PC

handwritten comments, inserting, 345
signatures with, 324-325

voice comments, inserting, 344
tabs, 3, 4

in dialog boxes, 8
paragraph tabs, setting, 77

tags. See XML (Extensible Markup
Language)

target frame, setting, 300-301
task panes, 10
Taskbar, 383
Tech Support, 33
technical documents, 225. See also book-

marks; footnotes and endnotes
AutoText, working with, 228-229
bibliographies, 236
building blocks, working with, 226-227
captions, creating, 240
equations, creating, 244-245
lines, numbering, 242-243
numbering lines in, 242-243
Quick Part building blocks, 

inserting, 226-227
Research task pane, working 

with, 230-231
symbols, inserting, 246-247
tables of figures, 241

templates. See also styles
changing, 88
chart templates, creating and saving, 168
copying functionality between, 352-353
creating, 86
defined, 38
Document Information Panel template,

selecting, 428
documents, creating, 38
global templates, loading/unloading, 352
macro-enable templates, 418
opening, 87
password protection for, 353
resetting documents, 90
sharing, 352-353

Templates/Charts folder, 168
text. See also foreign languages; format-

ting; printing; tables; text boxes;
themes; WordArt

aligning, 74
AutoCorrect feature, 60-61
AutoText, working with, 228-229
boundaries, showing, 382
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text (continued)
case of text, changing, 66
Click-And-Type text, 74
columns, working with, 176-177
comparing text formatting, 97
copying

with Clipboard, 52-53
with drag-and-drop, 51

default text options, changing, 388
deleting, 50-51
drag-and-drop, 50-51
editing, 50-51
effects

formatting, 66-67
options, 388

equation as text, displaying, 245
finding and replacing, 54-55

as you type, 569
header/footer text, tab stops for, 211
hidden text, 66

Document Inspector viewing, 314-315
printing, 384

hyphenation options, 56-57
inserting, 50-51
keyboard corrections, 50
pasting, 52-53
selecting, 48-49
shapes, adding to, 184, 187
showing/hiding, 84
size, increasing/decreasing, 18
watermarks, 173
wrapping text around object, 178-179

Text Box button, 424
text boxes

with cover pages, 223
defined, 169
in dialog boxes, 8
effects, 66-67
existing text, creating from, 180
inserting, 180
linking, 180-181
Office.com, 180
Quick Styles, adding, 186
shapes as, 184
showing on screen, 382
word count statistics, 222

Text pane. See also SmartArt graphics
resizing, 134

texture fills to shapes, 190
Theme Colors dialog box, 100
Theme Effects button, 106
themes, 100

accent colors, 100
applying, 101
custom colors, creating and 

applying, 102-103
custom themes

choosing, 108
creating, 107

defined, 85
deleting

custom themes, 107
effects, 106
fonts, 106

effects, choosing, 106
fonts, choosing, 104-105
hyperlink colors, 100
searching for, 101
viewing, 101

thesaurus, working with, 275
third-party add-ins. See add-ins
3-D charts, 162-163
3-D effects

in organization charts, 142
pictures, adding to, 117
for shapes, 192-193
for text, 66-67
to WordArt, 130

Thumbnail pane, displaying, 18-19
times. See dates and times
titles

chart titles, changing, 164
in headers or footers, 210
text boxes for, 180

Toggle button, 424
toolbars. See also Quick Access Toolbar

commands, choosing, 6
tools. See Groove
top-aligning objects, 194-195
Total Row option, 156
tracking changes

modifying options, 350



Index 505

printing documents with track 
changes, 349

reviewing changes, 349
as you work, 348-349

tracking changes on documents, 342-343
trademark symbols, 68
transform, opening document with, 12
translating text to foreign languages, 278
Translation, 278

keyboard language, 277
languages, 280
Mini Translator, 278-279

transparency
pictures, setting for, 122-123
shape color fill with transparency,

adding, 189
trendlines in charts, 166
Trojan Horses, 326-327
troubleshooting

objects, arrangement of, 201
XML file problems, 365

TrueType fonts, 65
kerning with, 68

Trust Center, 313, 326-327. See also add-ins;
macros; Message Bar; privacy

file block settings, 330-331
protected view, 330-331
safe mode, working in, 338-339
Trusted Publishers, Locations, 328-329
viewing, 328

Trusted documents, 328, 330
Trusted locations setting, 328, 329
Trusted publishers. See also ActiveX 

controls
setting, 328, 329

TuCows, 327
turning on/off ScreenTips, 6
2-D charts, 162-163
two-sided documents, printing, 290
TXT files, 25

U
underlining

long documents, formatting in, 208
shape text, 187

text, 64, 66
undoing

actions, 62
pictures, changes to, 399
shape changes, 188

up/down bars in charts, 166
updating

automatic links, 392
Automatic Updates, 327
checking, 312
diagnostics, 32
links, 363
printing, updating before, 384
table of contents, 218
Web updates, 33

uppercase text, 66
URLs (Uniform Resource Locators), 297
User-Initiated Safe mode, 338-339
USPS bulk mailing, sorting records for, 255

V
VBA (Visual Basic for Applications), 401. See

also macros; Visual Basic Editor
ActiveX controls, adding code to, 426
building projects, 407
function procedures, 407
harmful attacks and, 326-327
introduction to, 406-407
modules, working with, 407
procedures, 407
sub procedures, 407
writing code, 406

vector images, 110
vertical ruler, 76
video, playing, 427
view buttons, 3
viruses, avoiding, 326-327
Visual Basic Editor, 407-408

Modules window, 407-408
Object Browser, 407-408
Project Explorer, 407-408
viewing, 408

VML (Vector Markup Language), 306
voice comments, inserting, 344



506 Index

W
washout color option, 122
watermarks, 172-173
Web addresses, 297
Web Layout view, 16-17
Web pages. See also blogs; hyperlinks

appearance, changing, 295
browser, opening document in, 295
frames, 300-301
opening documents as, 294-295
options, changing, 306
previewing, 296-297
resizing, 305
saving document as, 304-305
single file Web page, saving document

as, 304-305
table of contents, links to, 218

white space
gutters with, 215, 282-283
page display options, setting, 381
showing/hiding, 287

Widow/Orphan control option, 285
widows, 285
width of columns, setting, 149, 150-151
wildcards, finding and replacing with, 73
windows

arranging, 43
copying contents of, 111
display, changing, 43
moving, 42
panes, resizing, 10
resizing, 10, 42
side-by-side, comparing, 44
splitting, 44-45
switching between, 43
viewing, 3

Windows Explorer
documents, opening, 2
starting Word from, 2

Windows Firewall, 327
Windows Live

adding files to, 443
copying documents, 444
creating documents, 442
deleting documents, 444
downloading files, 445-446

embedding links, 449-450
moving documents, 444
opening documents, 434-435
renaming documents, 444
saving documents, 434-435
sending links, 449
SkyDrive

browsing folders, 437-438
creating folders, 439
deleting folders, 440
renaming folders, 440
setting folder permissions, 441

Windows Live ID, 429-430, 432-433
sign-in, 433

Windows Live Spaces, 308, 311
Windows Mobile, 458
Windows Write, opening, 14
Word add-ins. See add-ins
Word Count button, 222
word count statistics, 222
Word-Macro-Enabled Documents, 418
Word-Macro-Enabled Templates, 86, 418
Word 97-2003 Templates, 86
Word Options. See also printing

add-in dialog box, opening, 404
Advanced pane options, 382-383
compatibility options, setting, 393
display options, changing, 383
editing options, 386-387
editing options, changing, 268
feedback options, 392
General pane, 409
Hidden Text option, 84
page display options, setting, 381
readability of documents, checking, 271
Save pane, 390-391
setting, 380
tracking changes, 342-343

Word Templates, 86
Word XML schema, 364

creating, 367
WordArt, 109

converting text to, 127
direction of text, changing, 131
editing text, 127
effects, applying, 130
existing text, apply different style to, 128
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fills, applying, 128-129
formatting text, 128-129
inserting, 127
rotating text, 131
shapes of text, 129
spacing, changing, 130

WordArt Quick Style gallery, 127
WordArt Styles group, 128
WordPerfect

compatibility options, setting, 393
opening, 14

words, selecting, 48-49
workbook (Excel)

Office Web App, creating, 485
workspace. See Groove
worms, 326-327
wrapping text

around object, 178-179
forcing text wrapping, 286
showing wrapped text, 382

X
XLStart folder, 410
XML Expansion Pack, 403
XML (Extensible Markup Language), 25, 357

associating XML transformation with
schema, 366

attaching/separating schemas, 364
Document Inspector viewing, 314-315
editing data files, 365
importing documents as, 360
inserting XML data, 367
opening XML data files, 365
options, changing, 364
printing tags, 385
saving documents in, 22, 367
tags

deleting, 365
printing tags, 385
Actions as properties, saving, 390

XML Transformations file (XSLT), 366-367
XPS (XML Paper Specification) files, 25

document as XPS file, sending, 354-355
saving document as, 377

Z
zip codes

mailing labels, 266
sorts letters by, 255

zip package, 421
zooming, 29

controls, 3
in Print Preview, 288
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